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ARCHICAD & FRILO
Integrated planning for architects & civil engineers
 
With this workflow paper from Archicad, the BIM software from 
GRAPHISOFT, and FRILO you receive a guideline that offers you an 
integrated BIM workflow. You will learn how to get from the Archi-
tecture model in Archicad to the Analytical model in FRILO, so that 
you can then control the FRILO design programs.
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ARCHICAD and FRILO 

Architects and civil engineers depend on each other in their day-to-day work. That is why all actors in the construc-
tion industry struggle with recurring difficulties. This includes long communication channels, constant planning 
changes, manual adjustments to projects and other tasks that take up time in everyday life. Time - that you as 
a user do not have. We are therefore looking for new ways and methods to enable a time-efficient and practical 
exchange between architects and civil engineers.

GRAPHISOFT and FRILO have therefore set themselves the task of providing users with a practical workflow that 
will help them master the challenges of everyday life. With the smart interface between Archicad and the FRILO 
Software, you can already become part of a holistic BIM workflow today. In this paper, not only will you learn more 
about the benefits of working together, but you will also receive step-by-step instructions for the way you work.

The OPEN BIM approach  

A central goal of BIM is to digitally map the entire life cycle of a building. This should create the greatest possible 
transparency for all project participants across the entire planning process. The OPEN BIM approach gives users 
the opportunity to exchange data from building models regardless of the software solution used. With end-to-end 
work processes, project participants should work together in a goal-oriented and efficient manner.

One thing is clear: many users view the OPEN BIM approach with skepticism. Doubts about the suitability for 
everyday use and big question marks in the use of this new approach are therefore not uncommon. An important 
prerequisite for the OPEN BIM approach is therefore that architects and structural engineers get to know and 
understand each other‘s planning processes. This is the only way to understand and overcome the challenges of 
the other project partners.

For this OPEN BIM idea to actually be implemented in reality, uniform exchange formats such as IFC and SAF files 
are required in practice. In addition to the well-known IFC format, the SAF file is also enjoying increasing popularity. 
These formats also play an elementary role in the following two workflows between Archicad and FRILO.

IFC

The abbreviation IFC stands for Industry Foun-
dation Classes. It is an open standard that is 
used for data exchange in the construction 

industry.

The IFC format allows the creator a software-
neutral description of building models. It can 
transmit geometry, attributes and descriptions 
of components as well as building structures.

The standard was developed by building 
SMART, under whose responsibility it is conti-

nuously being further developed.

SAF

SAF stands for Structural Analysis Format. 
This format also enables data to be exchan-
ged between those involved in the project.

However, the SAF file is an Excel-based 
format in which the components are trans-

ferred as members or surfaces.

This file format is particularly suitable for 
exchanging analytical models - for exam-
ple between different structural analysis 

programs.
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Faster project execution

A good project order situation should actually make every architect and structural planner 
happy. However, this mood is often clouded by time pressure in complex construction 

projects. The OPEN BIM approach enables you to work more efficiently and profitably in 
project management in the future.

Your advantages 

Part of the digital future

The AEC industry will increasingly digitize itself 
in the coming years. The networked building 

planning is a central component, which you can 
already experience with Archicad and FRILO. 
Do not be a straggler in this promising way of 

working, but already a pioneer in your field.

Record the planning chan-
ges immediately

You know this situation yourself. 
In every planning process there is 
constant corrections and adjust-
ments. The OPEN BIM approach 

enables you to capture these 
changes at an early stage and to 
pass it on to everyone involved in 

the project.

More time for the essentials

Communication costs time and 
energy. Thanks to the continuous 

Workflows between Archicad 
and FRILO, you can shorten these 

communication paths. This 
leaves you more time for your 

actual work:  
structural planning.

Avoid manual transmission errors 

Manual transfer errors from the Architecture to 
the Analytical model are not uncommon. 

The workflow between Archicad and FRILO trans-
fers relevant building data directly to the structu-
ral engineer, which means that sources of error 

can increasingly be minimized.

The holistic workflow between Archicad and FRILO and the OPEN BIM approach result in numerous advantages 
for users:
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Part 1: The Workflow in Archicad
A model that has been tailored to the requirements of the FRILO BIM-Connector® (FBC) forms the basis for ef-
fective collaboration between architects and civil engineers. Although the workflow using a SAF file is available 
between Archicad and FRILO, in this chapter we would first like to deal with the data exchange with an IFC file. 
For this purpose, some boundary parameters should be taken into account when creating the model and the 
export options should be adjusted accordingly.

The modeling
Archicad is predestined for exchanging information via the IFC format with FRILO due to its way of thinking in 
terms of floors. For modeling, it is therefore sufficient to adhere to the general modeling guidelines for Archi-
cad. These define how to model and classify. The necessary properties are also explained. 

These can be downloaded free of charge from  
https://openbim.graphisoft.de/open-bim-funktioniert/#modellierungsrichtlinie.

IFC-export
For the IFC export, the model should initially only be filtered for the core of the load-bearing elements. To do 
this, select the option “Core of Load-Bearing Elements Only” in the quick options bar in the structure display 
(see Fig.1).

Fig. 1: Option - „Only the core of the load-bearing elements“

Workflow 1: IFC as a working basis
One of the most common use cases within BIM-compliant pro-
ject management is the transfer of the architectural model to the 
structural engineer for structural design. This chapter deals with 
data exchange using an IFC file.

https://openbim.graphisoft.de/open-bim-funktioniert/#modellierungsrichtlinie
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Since FRILO only takes over the components necessary for the static calculation, a filter is already activated in 
the preset translator in Archicad. With this translator, only the following classified components are transferred:

	� Column/pillar
	� Point foundation
	� Strip foundation
	� Roof
	� Ceiling
	� Floor slab/flat foundation
	� Walls
	� Girder/beam/downstand beam

As a result of the reduction, only the components required for structural engineering are transferred. This leads 
to a faster export and less post-processing effort in the FRILO software. Since a material is already preset in 
the Archicad building materials, the materials are automatically written to the correct place in the IFC file and 
recognized (see table in the appendix). 

For the actual export, go to „File> Save as ...“ and select IFC with the preset FRILO translator. If the FRILO trans-
lator has not yet been preset in the project, the general translator IFC 4 can alternatively be selected.

Fig. 2: save IFC file
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Part 2: The Workflow in FRILO

In part 2 of the workflow, in addition to the IFC import from Archicad and the model structure, the clean up of 
the Physical model and the adaptation of the Analytical model are now considered.

If all the steps mentioned above have been followed in Archicad, the structural engineer receives a well-struc-
tured building model that has been reduced to the shell. Now it is time to import the generated IFC file into the 
BIM-Connector® (FBC) and check it.

IFC-import from Archicad 
Start by opening a File New (from IFC/SAF)
The Physical model of the imported IFC file opens (Fig. 3).

Fig. 3: the imported Physical model

Model structure
After you have opened the Physical model, it must first be adapted and prepared so that the export to the FRILO 
programs works correctly.

The first step is to check the model structure and revise it if necessary. The floors for calculation can be auto-
matically restructured using the „Floor allocation“ function. From the previous view from „top to bottom“, as is 
usual for architects, the view from „bottom to top“ usual for structural engineers can be generated.

From the Physical model to the Analytical model
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Clean up Physical model

Fig. 4: “load-bearing” and “non-load-bearing” compo-
nents

2. Specifications for calculation and material

The „Specifications“ function offers a convenient way 
of specifying material qualities. The „Specifications“ 
function can be used to specify material qualities that 
are to be used if the components have not been ex-
plicitly assigned a material quality. Furthermore, the 
corresponding design standards can be specified 
here (see Fig. 5).

Fig. 5: Define material quality

As soon as all components have the correct materials and the model has been adjusted to include the non-lo-
ad-bearing components, you can switch to the Analytical model. Only the load-bearing components are shown 
there.

1. Remove non-relevant components

After the IFC file has been imported, the Physical mo-
del should first be cleared of all components that are 
irrelevant for the calculation. The fastest way to do 
this is to use the „Load transfer via material“ function 
in the group of functions for load transfer. Here all 
components relevant for load transfer can be set to 
„load-bearing“ and all components irrelevant to load 
transfer to „non-load-bearing“ (see Fig. 4).

3. Assign the material

Another option for defining materials or quality of ma-
terial is offered by the „Material“ function in the ribbon 
bar. The materials used are shown in different colors. 
Gray components consist, for example, of concrete or 
pink components of masonry. The red components 
are still missing any material assignment.

With the help of the various selection and display op-
tions (visibility, model structure, etc.), for example, all 
walls can be selected in no time at all. With the help of 
the „Material“ (properties) function, all selected walls 
can be assigned the appropriate material and the as-
sociated material quality with one click.

Fig. 6: Assigning material
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Adapt the Analytical model
In the second step, the Analytical model is adapted. Various functions serve as the basis for this:

1. Join - intersect gravity lines
Due to the derivation of the Analytical model from the Physical model, the components are not yet joined. The 
„Join automatically“ function is suitable for this.

Fig. 7: Unjoined components Fig. 8: Joined components

2. Move components
Axis-related modeling is particularly important for vertical load transfer. With the „Move components“ function, 
the component axes can be pushed over one another so that the loads can be passed on.

Fig. 9: Division into wall strips

3. Disassemble walls
Using the “Disassemble walls” function, either all walls can be processed at once or only the selected walls 
can be processed in different ways according to their openings. This means that existing openings can be 
taken into account in the Analytical model.

4. Calculated thickness
Using the „Thickness“ function, surface elements (walls, floors) can be assigned a new calculated thickness.

5. Conversion
With the „Conversion“ function, flat components can be converted into rod-shaped components and vice ver-
sa.

6. Clean up the geometry
With the „Reset geometry“ function, small recesses and openings as well as small beam sections, columns, 
walls and slabs, which should not be taken into account in the static calculation, can be removed.
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Export to the FRILO-programs
After cleaning up the Physical model and preparing the Analytical model, a component can be selected in the 
next step and either
1.	 with the export button or
2.	 transferred with a right click on „Export to FRILO program“.

If no component is selected, all components from the Analytical model are automatically transferred to the 
GEO Building model.

The component design then takes place in the Analytical program.

Löser+Körner Planungsgesellschaft GmbH & Co. KG
Designer adjusting the structural analysis model in Archicad
©Alex Brunner, Berlin
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Part 1: The workflow in Archicad

SAF transmission
There is a direct connection between Archicad and FRILO using the SAF standard. This is made possible be-
cause in Archicad the structural analysis model for the static calculation can be derived directly from the Ar-
chitecture model. The structural analysis model in FRILO corresponds to the Analytical model. The advantage 
here is that an up-to-date structural analysis model is always available during the course of the project, without 
having to make time-consuming manual adjustments.

Derive the structural analysis model
In addition to the working environments for architecture and building services, Archicad offers a working envi-
ronment for structural engineering. You can access this working environment in the menu via „Options > Work 
Environment > Apply Profile“ (see Fig. 10).

Fig. 10: Derive structural analysis model

Workflow 2: SAF as a working basis
As an alternative to the use of IFC files, the SAF format can 
be used for the workflow between Archicad and FRILO. In 
the following workflow, first the processing in Archicad and 
then the processing in the FRILO software is described.
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Fig. 11: Presettings for creation rules

The functions for deriving the structural analysis model are available in the toolbar:

You can now display the structural analysis model here. The model is adapted on a rule-based basis in order 
to also cope with complex projects.

You can preset rule sets for certain structures in order to quickly and easily derive the model according to your 
ideas (see Fig. 11).

Fig.12: Intersection situation before and after application of a rule set

With the rule sets, even complicated situations with columns, beams and offsets between walls (see Fig. 12) 
can be quickly adapted to a continuous model.
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Fig. 14: Ignored ceiling breakthrough in a sewer pipe

Fig. 13: Determine the size of the openings

As part of the creation rules, openings (small breakthroughs) or narrow areas of plates or slabs can also be 
ignored for the structural analysis model. Networking and calculation results in FRILO can thus be improved.
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SAF settings
The corresponding assignments must be made so that all materials can be adequately adopted. This can be 
found under „File> Interoperability> SAF> SAF translator ...“. The individual materials can then be assigned 
here. It should be noted that the names entered in the SAF building material correspond to the FRILO names.

In this way
	� Concrete,
	� Masonry,
	� Steel,
	� Wood,
	� Aluminum

can be correctly assigned and transferred. For masonry in particular, it should be emphasized that common 
types are clearly identified via the short type, class and mortar group and passed on to FRILO.

FRILO can be opened from Archicad via the direct connection. 
To do this, simply select the „Open in FRILO ...“ symbol:
This function is available from version Archicad 25 Update 2.

Another option would be to save the model as a SAF structural analysis file on your computer via „File> Save 
as ...“. After this process, it can be further edited in the FRILO Software.

Fig. 15: Material assignment in SAF Export



ARCHICAD - FRILO 10/2021    |    Seite 14

Part 2: The workflow in FRILO

The workflow with a SAF file
The difference to the previous workflow (IFC file) is that the SAF input file for the BIM-Connector® is not based 
on architecture plans, but rather on a structure analysis model. The engineer and modeler work on the same 
model and the structure analysis model is derived directly from Archicad, which means that the BIM-Connec-
tor® (FBC) can already be started in the program interface of the Analytical model.

With Archicad 25 Update 2 you can start the BIM-Connector® via a button and automatically transfer SAF files 
from the Archicad user interface.

SAF import
Unlike the previous workflow (IFC file), the Physical model does not open, but the Analytical model of the im-
ported SAF file.

With a SAF file, structure analysis data is transferred, i.e. a model consisting of bar and surface elements and 
not, as with the IFC file, of volume elements.

When importing a SAF file, there is usually less need to adapt in the FBC. In the case of SAF files, for example, 
the components are transferred already connected and the materials are also already assigned.

For subsequent editing of the model, however, the same editing functions are available in the FBC as in the 
previous workflow.

Fig. 16: The Analytical model
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Appendix
Frequently asked questions

Are there any prerequisites that must be met for the two workflows?
The “Open in FRILO” icon in the Archicad interface only works if both Archicad and FRILO are installed on the 
computer. Furthermore, installation on a Windows operating system is a basic requirement, as FRILO does not 
have a version for MAC.

Which program version is required for the workflow?
FRILO R-2021-1 
Archicad 24 (IFC, SAF) /Archicad 25 Update 2 for using the „Open in FRILO“ icon.

Which FRILO design programs are linked to the BIM-Connector®?
In the 2021-1 release, the BIM-Connector® is connected to the PLT Slabs by Finite Elemens and the Reinfor-
ced Concrete Column B5+. From Release 2022-1, the BIM-Connector® is also connected to the GEO Building 
Model.

Which file formats can the BIM-Connector® read in?
The BIM-Connector® can import both IFC files (IFC 2x3 and IFC4) and SAF files.

Which IFC component types are currently recognized by the BIM-Connector®?
	� IfcWall  
	� IfcBeam  
	� IfcColumn  
	� IfcSlab  
	� IfcFooting  
	� IfcRoof  
	� IfcMember 
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Material Considered components of the 
name 

Considered material quality 

Reinforced Concrete „concrete“ Cxx/xx or LCxx/xx
e.g. C25/30 or LC20/22 22  
(all common material grades)

Masonry „masonry“
„brick“
„blockwork“
„clinker“
„aerated concrete“
„poroton“
„bisotherm“

Steel „steel“ Sxxx
e.g. S235  
(all common material grades)

Timber „timber“
„glulam“
„osb“

Softwood:
C14, C16, C18, C20, C22, C24, C27, 
C30, C35, C40, C45, C50

Hardwood:
D18, D24, D27, D30, D35, D40, D45, 
D50, D55, D60, D65, D70, D75, D80

Glued laminated timber:
GL20c, GL20h, GL22c, GL22h, GL24c, 
GL24h, GL26c, GL26h, GL28c, GL28h, 
GL30c, GL30h, GL32c, GL32h

(Aluminum) „aluminum“ -

Material table

For automatic assignment to the predefined materials of the FRILO BIM-Connector®, the value entry must con-
tain one of the following character strings. The material quality has the highest relevance or priority. If no cor-
responding entry is found here, the next step is to search for suitable components that enable an assignment. 
The material specification is not „case sensitive“ (there is no distinction between upper and lower case letters) 
and ignores spaces in order to achieve the greatest possible correspondence.
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FRILO Software GmbH
Stuttgarter Straße 40
70469 Stuttgart
Tel:	 +49 711 81 00 20  
Fax:	 +49 711 81 00 230
www.frilo.eu
info@frilo.eu
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